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. Microchip is willing to work with the customer who is concerned about the integrity of their code.

. Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their code. Code protection does not
mean that we are guaranteeing the product as “unbreakable.”

Code protection is constantly evolving. We at Microchip are committed to continuously improving the code protection features of our
products. Attempts to break Microchip’s code protection feature may be a violation of the Digital Millennium Copyright Act. If such acts
allow unauthorized access to your software or other copyrighted work, you may have a right to sue for relief under that Act.
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intellectual property rights.
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Preface

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and
documentation are constantly evolving to meet customer needs, so some actual dialogs
and/or tool descriptions may differ from those in this document. Please refer to our web site
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each
page, in front of the page number. The numbering convention for the DS number is
“DSXXXXXA", where “XXXXX” is the document number and “A” is the revision level of the
document.

For the most up-to-date information on development tools, see the MPLAB® IDE on-line help.
Select the Help menu, and then Topics to open a list of available on-line help files.

INTRODUCTION

This chapter contains general information that will be useful to know before using the
MCP16323 Evaluation Board. ltems discussed in this chapter include:

* Document Layout

» Conventions Used in this Guide

* Recommended Reading

» The Microchip Web Site

» Customer Support

* Document Revision History

DOCUMENT LAYOUT

This document describes how to use the MCP16323 Evaluation Board. The manual
layout is as follows:

» Chapter 1. “Product Overview” — Important information about the MCP 16323
Evaluation Board.

» Chapter 2. “Installation and Operation” — Includes instructions on how to get
started with the MCP16323 Evaluation Board and a description of the user’s
guide.

* Appendix A. “Schematic and Layouts” — Shows the schematic and layout
diagrams for the MCP 16323 Evaluation Board.

* Appendix B. “Bill of Materials” — Lists the parts used to build the MCP16323
Evaluation Board.

© 2011 Microchip Technology Inc. DS52029A-page 5
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:
DOCUMENTATION CONVENTIONS

Description

Represents

Examples

Arial font:

Italic characters

Referenced books

MPLAB® IDE User'’s Guide

Emphasized text

...Is the only compiler...

Initial caps A window the Output window
A dialog the Settings dialog
A menu selection select Enable Programmer
Quotes A field name in a window or | “Save project before build”
dialog
Underlined, italic text with A menu path File>Save
right angle bracket
Bold characters A dialog button Click OK

A tab

Click the Power tab

N‘Rnnnn

A number in verilog format,
where N is the total number of
digits, Ris the radix and nis a
digit.

4'b0010, 2'hF1

Text in angle brackets < >

A key on the keyboard

Press <Enter>, <F1>

Courier New font:

Plain Courier New

Sample source code

#define START

Filenames autoexec.bat

File paths c:\mccl8\h

Keywords _asm, _endasm, static
Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants OxFF, ‘A’

Italic Courier New

A variable argument

file.o, where file can be
any valid filename

Square brackets [ ]

Optional arguments

mccl8 [options] file

[options]

Curly brackets and pipe
character: {| }

Choice of mutually exclusive
arguments; an OR selection

errorlevel {0]|1}

Ellipses...

Replaces repeated text

var _name [,
var _nane. . .|

Represents code supplied by
user

void main (void)
{
}

DS52029A-page 6
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RECOMMENDED READING

This user's guide describes how to use MCP 16323 Evaluation Board. Other useful doc-
uments are listed below. The following Microchip documents are available and
recommended as supplemental reference resources.

« MCP16323 Data Sheet —“18V Input, 3A Output, High Efficiency
Synchronous Buck Regulator with Power Good Indication” (DS22284)

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web
site is used as a means to make files and information easily available to customers.
Accessible by using your favorite Internet browser, the web site contains the following
information:

* Product Support — Data sheets and errata, application notes and sample
programs, design resources, user’s guides and hardware support documents,
latest software releases and archived software

* General Technical Support — Frequently Asked Questions (FAQs), technical
support requests, online discussion groups, Microchip consultant program
member listing

* Business of Microchip — Product selector and ordering guides, latest Microchip
press releases, listing of seminars and events, listings of Microchip sales offices,
distributors and factory representatives

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

+ Distributor or Representative

* Local Sales Office

* Field Application Engineer (FAE)
 Technical Support

Customers should contact their distributor, representative or field application engineer
(FAE) for support. Local sales offices are also available to help customers. A listing of
sales offices and locations is included in the back of this document.

Technical support is available through the web site at: http://support.microchip.com.

DOCUMENT REVISION HISTORY

Revision A (November 2011)

« Initial Release of this Document.

© 2011 Microchip Technology Inc. DS52029A-page 7
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Chapter 1. Product Overview

1.1 INTRODUCTION

This chapter provides an overview of the MCP16323 Evaluation Board and covers the
following topics:

« MCP16323 Short Overview
* What is the MCP16323 Evaluation Board
« MCP16323 Evaluation Board kit contents

1.2 MCP16323 SHORT OVERVIEW

The MCP16323 is a highly integrated, high-efficiency, fixed frequency, synchronous,
step-down DC-DC converter in a popular 16-pin QFN package that operates from input
voltage sources up to 18V. Integrated features include a low resistance high-side
switch, low resistance low-side switch, 1.0 Mhz fixed-frequency peak-current mode
control, internal compensation, power good output, peak current limit, Vo overvolt-
age and overtemperature protection. Minimal external components are necessary to
develop a complete step-down DC-DC converter power supply. The MCP16323 draws
less than 10 pA while disabled.

High converter efficiency is achieved by integrating the current limited, low resistance,
high-speed N-Channel MOSFETs and associated drive circuitry. Incorporating both the
upper and lower switches reduces the need for external components. High switching
frequency minimizes the size of external filtering components resulting in an overall
small solution size.

The MCP16323 can supply 3A of continuous current while regulating the output voltage
from 0.9V to 5V. An integrated high-performance peak-current mode architecture
keeps the output voltage tightly regulated even during input voltage steps and output
current transient conditions that are common in power systems.

© 2011 Microchip Technology Inc. DS52029A-page 9
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Pgood
10kQ
CBOOST
22 nF
L1
Vin PG BOOST 47 uH Vour
6.0V to 18V Vi SW y 3.0V @3A
Cn L MCP16323 100 L Cour
2x10puF [ EN INJ 2x22 uF
EN FB
Senp Psno 10k0% 23.2kQ
FIGURE 1-1: Typical MCP16323 Buck Application.

1.3 WHAT IS THE MCP16323 EVALUATION BOARD?

The MCP16323 Evaluation Board is designed to operate from a 6V to 18V input and
regulate the output to 3.0V. Test points for input power and load are provided to dem-
onstrate the capability of the MCP 16323 Evaluation Board over the entire range. The
MCP16323 Evaluation Board was designed using small surface-mount components to
show application size for a high-voltage buck design.

1.4 MCP16323 EVALUATION BOARD KIT CONTENTS

This MCP16323 Evaluation Board kit includes the following items:

* MCP16323 Evaluation Board, 102-00427
* Important Information Sheet

DS52029A-page 10 © 2011 Microchip Technology Inc.
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Chapter 2. Installation and Operation

2.1 INTRODUCTION

2.1.1 MCP16323 Features

The MCP16323 devices have been developed to provide high input voltage, high
current applications with a precisely regulated rail while operating at high efficiency.

The key features of the MCP16323 include:

» Up to 95% Typical Efficiency

* Input Voltage Range: 6.0V to 18V

» Output Voltage Range: .9V to 5V

* 1.5% Output Voltage Accuracy

* Integrated High-Side N-Channel Switch: 180 mQ
* Integrated Low-Side N-Channel Switch: 120 mQ
* 3A Output Current MCP16323

* 1 MHz Fixed Frequency

+ Adjustable Output Voltage

* Low Device Shutdown Current

» Peak Current Mode Control

* Internal Compensation

+ Stable with Ceramic Capacitors

* Internal Soft-Start

» Cycle by Cycle Peak Current Limit

» Under Voltage Lockout (UVLO): 5.75V (typical)
» Output Overvoltage Protection

» Overtemperature Protection

* Available Package: QFN-16

A high-performance peak-current mode control system is used to deliver a fast
response to sudden line and load changes.

2.1.2 MCP16323 Evaluation Board Features

The MCP16323 Evaluation Board is developed to demonstrate how the MCP16323
device operates as a Buck Topology over a wide input voltage and load range. Test
points are provided for input and output, allowing the MCP16323 Evaluation Board to
be connected directly to a system. Test vias are also included to give the user easy
access to the switch, power good, enable and injection nodes for easy evaluation of the
device. There are also ancillary vias provided for attaching extra input and output con-
nections. The 3A maximum continuous output current is available over the entire V|y
range (6.0V to 18.0V), along with the entire adjustable output voltage range (0.9V to
5.0V).

A copper via, labeled Pgood, connected to the power good pin on the device can be pop-
ulated to monitor the power good output of the device. The power good pin is externally
pulled up to Vot with a 10 kQ resistor (R2).

© 2011 Microchip Technology Inc. DS52029A-page 11
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A copper via, labeled INJ, connected between the 10Q injection resistor (R1) and the
Riop resistor can be populated to allow a convenient injection point for stability analysis.

A copper via, labeled Enable, connected to the enable input on the device can be pop-
ulated and used to turn the MCP 16323 on and off. Turning the device on (Enable >
2.2V) when the undervoltage lockout threshold is met (V|y > 5.75V), will enable the
device. This pin must be pulled low (Enable < 0.8V) to disable the device.

A copper via, labeled SW, connected to the switch node of the device can be populated
to analyze the switch node of the device.

2.2 GETTING STARTED

The MCP16323 Evaluation Board is fully assembled and tested to evaluate and dem-
onstrate the MCP16323 operational capabilities.

2.2.1 Power Input and Output Connection

2211 POWERING THE MCP16323 EVALUATION BOARD

The MCP16323 Evaluation Board is fully assembled, tested and ready to begin evalu-
ation. Apply positive input voltage to the V| terminal and its return to the GND terminal.
The maximum input voltage should not exceed 18V. An electronic load or resistive load
can be used for evaluation, or the intended system load can be connected. Electronic
loads attempt to sink current at OV during startup; a resistive load or constant resis-
tance is recommended for startup evaluation. Connect the positive voltage terminal of
the load to the Vg1 terminal on the MCP 16323 Evaluation Board and connect the neg-
ative or return side of the load to the GND terminal.

2212 BOARD TESTING

To test the board:

1. Apply greater than 6V to the input for proper operation, no minimum load is
required to regulate the output to 3.0V.

2. The EN input is internally pulled up to a low voltage internal source enabling the
device. To disable the device, the EN input can be pulled below 0.8V.

3. The measured output voltage should be 3.0V typical. Adjusting the input voltage
and load should not cause the output to vary significantly over the operating
range of the converter.

2.2.2 How the MCP16323 High-Side Drive Boost Circuit Operates

The MCP16323 integrates both high-side and low-side, low resistance N-Channel
MOSFETSs. A high-side or floating supply is needed to drive the gate of the high-side
N-Channel MOSFET above the input voltage to turn it on. The evaluation board uses
the output voltage to charge the boost cap while the inductor current flows. Prior to
startup, there is no inductor current, so an internal pre-charge circuit charges the boost
cap up to a minimum threshold. Once charged, the N-Channel can be turned on, ramp-
ing current into the inductor.

The worst case operating conditions for charging the boost capacitor occur at minimum
V|n and no load. At minimum V) (6V), there is not enough headroom to pre-charge the
boost cap to a high value. At no load, the converter is operating at a minimum or very
low duty cycle, putting a small amount of current into the inductor. When the switch
turns off, the inductor current decays very quickly, resulting in a short time to recharge
the boost capacitor.

DS52029A-page 12
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Appendix A. Schematic and L ayouts

A.1 INTRODUCTION
This appendix contains the following schematics and layouts for the MCP16323
Evaluation Board:
* Board — Schematic
» Board — Top Layer
» Board — Top Copper Layer
» Board — Bottom Copper Layer

© 2011 Microchip Technology Inc. DS52029A-page 13
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A.3 BOARD -TOP LAYER
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Appendix B. Bill of Materials
TABLE B-1: BILL OF MATERIALS (BOM)
Qty | Reference Description Manufacturer Part Number
1 |C1 CAP 22000pF 25V CERAMIC X7R 0603 | AVX Corporation 0603YC104KAT2A
10%
2 |C2,C3 CAP 10uF 35V CERAMIC X7R 1210 20% | Taiyo Yuden GMK325AB7106MM-T
2 |C4,C5 CAP 22uF 6.3V CERAMIC X7R 1206 10% | Murata GCM31CR70J226KE23L
1 |L1 XAL6060 4.7uH Shielded Power Inductor | Coilcraft XAL6060-472MEB
1 |PCB MCP16323 6V to 18V VIN, 3.3V Printed | Microchip Technology Inc. | 104-00427
Circuit Board
1 |R1 RES 10.0 OHM 1/10W 1% 0603 SMD Yageo RCO0603FR-0710RL
2 |R2, Rbot RES 10.0K OHM 1/10W 1% 0603 SMD Yageo RC0603FR-0710KL
1 |Rtop RES 23.2K OHM 1/10W 1% 0603 SMD Yageo RC0603FR-0723K2L
1 |U1 MCP16323 High Input Buck Converter Microchip Technology Inc. | MCP16323
QFN16
4 |VIN, VOUT, |PC TEST POINT COMPACT SMT Keystone 5016
GND, GND
Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The

released BOM used in manufacturing uses all RoHS-compliant components.

© 2011 Microchip Technology Inc.
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